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INTRODUCTION

ZipShell Pro is a program for the Microsoft Windows environment 
which allows the user to easily access the power of data 
compression technology without spending the large amounts of time 
required to become proficient in the use of various 
compression/decompression programs (i.e., archivers).

ZipShell Pro acts as a command center for creating, modifying and 
extracting archives in 4 major formats:  ARC, ARJ, LZH, and ZIP. 
Using ZipShell Pro, you may treat these different archives in the 
same way; ZipShell Pro takes care of their differences 
automatically.  There is no need to learn a different command set 
for each type of archive.

ZipShell Pro allows the user to perform more complex tasks, such 
as archive comment manipulation, password encryption, and self-
extracting archive creation, with a few keystrokes or mouse-
clicks.  Simple tasks, such as compressing or extracting files, 
often require as few as 1 or 2 keystrokes or mouse-clicks.

ZipShell Pro is constantly being updated to reflect new archiver 
versions and is continually being fine-tuned in terms of speed 
and performance, making it a powerful tool for archive 
management.

ZipShell Pro is not a free program; rather, it is Shareware.  
After evaluating ZipShell Pro for 21 days, you are obligated to 
either register it or discontinue using it.  See the 
"REGISTRATION" section later in this document for more details.



NEW FEATURES

ZipShell Pro 3.0 has many new features added since the last 
version.  Among them are:  Internal ZIP Compression (resulting 
archives are 100% compatible with PKZIP/PKUNZIP), archive 
conversion between archive types or versions (for example, ARJ to 
ZIP, or ZIP 1.10 to ZIP 2.04), and improved status display during 
internal archiving operations.

Also new to ZipShell 3.0 is the ability to create Windows SELF-
EXTRACTING ARCHIVES from any ZIP archive.  ZipShell Pro can turn 
any ZIP archive (with few exceptions) into a stand-alone, Win 3.1 
executable that can extract itself on any system without the aid 
of PKUNZIP or any other program or DLL.  It is a Windows program; 
however, such archives are still 100% compatible with 
PKZIP/PKUNZIP so DOS access is possible if necessary.

New to ZipShell Pro 3.1 is the ability to use ZipShell's internal 
unzip with zipfiles that contain paths.  Also, the WinSFX module 
has been rewritten and now sports a better interface.

SYSTEM REQUIREMENTS

In order to run ZipShell Pro, your system must meet the following 
minimum requirements:

* 80286 or higher processor (80386 or higher recommended)
* 2 Megs RAM
* Windows 3.1

In addition, you must also have copies of any of the DOS-based 
archivers you wish ZipShell Pro to utilize, although ZipShell Pro 
can perform many functions without the presence of any other 
archiver.

SUPPORTED ARCHIVERS

In order to perform some of its functions, ZipShell Pro requires 
the presence of third-party, DOS-based archivers.  These 
archivers may be present anywhere on your system (ZipShell Pro 
will prompt you for their location the first time they are used). 
You only need archivers appropriate for the type(s) of archives 
you wish to use.  Also, ZipShell Pro is able to extract most ZIP 
and ARJ files internally, and compress ZIP archives internally, 
without using an external program.  The supported archivers are 
as follows:

for ZIP files:  PKZIP.EXE & PKUNZIP.EXE, any version
    by PKWARE, Inc.

for ARJ files:  ARJ.EXE, version 2.30 or later
    by Robert Jung

for LZH files:  LHA.EXE, version 2.1x
    by Haruyasu Yoshizaki



for ARC files:  ARC.EXE, version 6.02 or later
    by System Enhancements Associates, Inc.

INSTALLATION

To install ZipShell Pro, use the included setup program.  Most of 
the files used by the setup program are compressed and may not be 
installed manually.

After all the required files are copied to your hard drive, you 
will be asked to enter your registration information.  If you are 
evaluating a shareware version of ZipShell Pro, just press the 
"Skip" button.  If you are installing a registered version, enter 
your name, company and serial number in the spaces provided.  The 
serial number is located on the disk label of the ZipShell Pro 
disk.

ZipShell Pro is an "ini-friendly" program and does not write 
information to either the WIN.INI or SYSTEM.INI files, but rather 
creates its own ZIPSHELL.INI file.

By default, ZipShell Pro supports the use of PKZIP/PKUNZIP 
version 2.04x.  If you are using PKZIP/PKUNZIP version 1.10, it 
is ESSENTIAL you follow these instructions:  Select the Options 
command from ZipShell Pro's Setup menu, then press F4 (or click 
on the Archivers piture) to go to the archivers section.  Then, 
select the option button labelled "1.10" next to the PKZIP.EXE 
label at the upper-left part of the screen.  Press the OK button, 
and this information will be saved to disk, and ZipShell Pro will 
work properly with the software you have.

ZipShell Pro assumes you have the same version of PKZIP and 
PKUNZIP, so if you specify a version of 1.10 for PKZIP.EXE, it 
will assume you have PKUNZIP.EXE, version 1.10, also.  If you 
later upgrade to PKZIP/PKUNZIP version 2.04, it is important you 
repeat these steps, this time selecting the option button 
labelled "2.04" next to the PKZIP.EXE label.

DE-INSTALLATION

If you later decide you wish to uninstall ZipShell Pro, there are 
a number of files ZipShell Pro copies to your hard drive that 
reside in locations other than your ZipShell directory.  You may 
safely delete these files if you no longer wish to use ZipShell 
Pro.

in your /windows directory:
ZIP001.PIF
ZIP002.PIF
LZH001.PIF
ARC002.PIF
ARJ001.PIF
ZIPSHELL.INI

In addition, the following shared files are installed to your 



/windows/system directory.  You may delete them only if you are 
sure they are not being used by other programs.  

CMDIALOG.VBX
CTL3D.DLL
THREED.VBX
VBRUN300.DLL

EXTRACTING ARCHIVES WITH ZIPSHELL PRO

The first thing most users will probably want to do with ZipShell 
Pro is to use it to extract (decompress) files from an existing 
archive.  The steps to do so are simple.

First, you must open the archive by using one of the Open 
commands from the File menu (for now, use the Open/Current Window 
command).  After you do this, ZipShell Pro will scan the archive 
and list its contents on the screen.  

NOTE:  You may also open an archive by dragging its filename from 
the File Manager (or Norton Desktop for Windows) and dropping 
anywhere on the ZipShell Pro window (or icon, if it's minimized).

If the archive you just opened contained an archive comment, the 
word "NOTE" will appear on the scrap of paper dispalyed on the 
Comment button.  You may press this button now to view the 
comment.  When you are done viewing the comment, press the OK 
button to return to the main ZipShell Pro display.

When you are ready to begin the extraction process, press the 
Extract button.  Another window will appear with two large 
listboxes.  The first box, which initially contains a list of all 
the files in the archive, represents the files you wish to 
extract from the archive.  The second box, which is initially 
empty, represents files which you do NOT wish to extract from the 
archive.  To move files from one box to the other, select them 
and press the appropriate Move button.

After having placed all the files you wish to extract in the 
first listbox, locate the text box towards the bottom of the 
window with the caption "Extraction Path".  This is the location 
the files will be extracted to.  Enter an appropriate path and 
press the Extract button.  If the path you entered does not 
exist, ZipShell Pro will optionally create it for you.

If the archive you are working with is a ZIP or ARJ archive, an 
additional window will be displayed, allowing you to select from 
additional extraction options.  For now, just ignore these 
options and press the OK button.  ZipShell Pro will now extract 
the specified files using its internal extraction routines.  The 
name of the file currently being extracted will be displayed on 
ZipShell Pro's status bar.  When the process is complete, 
ZipShell Pro will display the word "Ready" on its status bar.

If the archive you are working with is a LZH or ARC archive, 
ZipShell Pro will search for a DOS-based archiver to use.  If it 



doesn't find one, it will prompt you to enter its location.  
After doing so, ZipShell Pro will launch the archiver in a 
minimized DOS window to extract the files.

VIEWING FILES WITHIN AN ARCHIVE

If you wish to quickly view any file inside of an archive, simply 
double-click on its filename in the list displayed by ZipShell 
Pro after you open the archive.  The file will be extracted to a 
temporary location and displayed on the screen for you to view.  
When ZipShell Pro is closed, these temporary files are deleted.

The program ZipShell Pro uses to display viewed files is 
modifiable.  By default, ZipShell will search for an appropriate 
program to use for the type of file you wish to use.  For 
example, if you wished to view the file "PICTURE.BMP" inside of 
an archive, ZipShell Pro might use Windows Paintbrush or other 
bitmap viewer (it actually scans the [Extensions] section of your 
WIN.INI file to see what program is associated with BMP files).  
If no program is associated with the type of file you wish to 
view, ZipShell Pro will use Windows Notepad as the default 
viewer.

You may specify which programs ZipShell Pro uses to view programs 
by selecting Options from the Setup menu.  In the General Options 
dialog displayed, use the Default Viewer section to specify which 
viewer you wish ZipShell Pro to use if no other suitable program 
is found to view a particular type of file.  Use the Viewer 
Behavior section to specify whether you want ZipShell Pro to 
always use the Default Viewer, always use an associated program 
if any is found, or to ask you each time you view a file whether 
you wish to use the Default Viewer or the associated program, if 
any.

ADDING FILES TO AN EXISTING ARCHIVE

Adding files to an existing archive is equally simple.  First, 
open the archive you wish to add files to as described in the 
"EXTRACTING ARCHIVES WITH ZIPSHELL PRO" section.  Next, minimize 
ZipShell Pro to an icon.  Now, using Windows File Manager or the 
Norton Desktop for Windows, select the files you wish to add to 
the archive and drag and drop them on top of ZipShell Pro's icon.

ZipShell Pro will then display a dialog box listing the files you 
have chosen for the compression process.  At this time, you may 
cancel the operation by pressing the Cancel button.  Also, there 
is a check box with the caption "Delete original files after 
adding them to archive."  If this box is checked when the OK 
button is pressed, the files will be deleted after they are added 
to the archive.  If an error occurs during the compression 
process, the files WON'T be deleted, even if this box is checked.

Next, if you are working with a ZIP or ARJ archive, a window will 
be displayed listing additional compression options.  For now, it 
is all right to ignore these and press the OK button.  ZipShell 



Pro will now prompt you for the location of the appropriate 
archiver it needs to use if can't find it, and then will launch 
it in a minimized DOS window.  When the process is complete, 
ZipShell Pro will re-read the archive in order to update its 
display.

NOTE:  As an alternative method of adding files, instead of 
minimizing ZipShell Pro and selecting files from the File 
Manager, you may press the Add Files button. Doing so will 
display a window that enables you to select files for compression 
without using an external program.

CREATING A NEW ARCHIVE

Creating a new archive is similar to adding files to an existing 
archive as outlined above with one major exception:  instead of 
opening the archive you wish to add files to, you begin with an 
empty, untitled archive.  Then the process continues as above 
except that you are prompted for the name of the archive to be 
created before the appropriate archiver is launched.  The name of 
the archive will determine its format; i.e., archive.zip will be 
created using PKZIP.EXE (or ZipShell Pro's internal zipper), 
archive.arj will be created using ARJ.EXE, and so on.

When ZipShell Pro starts, it initially displays an empty, 
untitled archive.  You may use this as the basis for creating a 
new archive.  If you wish to create a new, untitled archive at 
any other time follow one of these two procedure:

1)  Select the Close Archive command from ZipShell Pro's File 
menu.  This will close any currently open archive displayed and 
replace it with an empty, untitled archive.

2)  Select the New Archive command from ZipShell Pro's File menu. 
This will create a new window containing an empty, untitled 
archive.  Any archives currently open will remain open, and you 
may switch to these using the Window menu.

DELETING FILES FROM AN ARCHIVE

To delete files from within an archive, you must first open it 
using one of the Open commands from the File menu.  Then, after 
the archive's contents are displayed, select the files you wish 
to delete and press the Delete button.  ZipShell Pro will ask you 
for confirmation, and if you reply "Yes", the appropriate 
archiver will be launched and the selected files deleted.  
ZipShell Pro will then re-read the archive to update its display.

WORKING WITH SELF-EXTRACTING ARCHIVES

ZipShell Pro supports the creation and manipulation of self-
extracting (executable) archives in the ARJ, ZIP and LZH formats. 
To open a self-extracting archive, use one of the Open commands 
from the File menu.  Select "EXE Files" from the "List Files of 



Type" combo box at the bottom of the dialog to display all EXE 
files.  After selecting an EXE file, ZipShell Pro will 
automatically determine its format and display its contents on 
screen.

NOTE:  When opening a self-extracting archive, the drag-and-drop 
method is not available.  When a single file with an ARC, ARJ, 
LZH or ZIP extension is dropped on ZipShell Pro, it is opened and 
displayed.  Files of any other extension (including EXE files) 
are added to the current archive instead of being opened.

After opening a self-extracting archive, it may be used as any 
other.  All normal operations may be performed on it.

To create a self-extracting archive from an existing archive, 
choose the Make EXE command from the File menu after having 
opened it.  Choose either the small or large SFX module from the 
dialog which is displayed (depending on how many capabilities you 
want the self-extracting archive to have) and ZipShell Pro will 
create the EXE file for you.

ZipShell Pro also has the ability to create Windows self-
extracting archives from most ZIP archives.  (It cannot use ZIP 
archives which contain password encryption or path information.) 
Such archives are Windows stand-alone executables, which can 
extract themselves on any system running Windows 3.1, without the 
aid of PKUNZIP.EXE, ZipShell Pro, or any other program or DLL.  
Registered owners of ZipShell Pro may distribute these self-
extracting archives freely, without additional compensation to 
NewVision.  Unregistered users of ZipShell Pro may only make them 
for their own use.

To make a WinSFX file from any ZIP archive, choose the Make 
WinSFX command from ZipShell Pro's File menu.  WinSFX files can 
contain only ZIP 2.04 compatible compression.  If earlier 
compression types are detected, ZipShell Pro will offer to 
convert the archive to version 2.04 first.  Then, ZipShell create 
a stand-alone, Windows executable with the same name and open it 
up for you to view.

ARCHIVE COMMENT MANIPULATION

If an open archive contains an archive comment, the word "NOTE" 
will appear on the piture of the scrap of paper on the Comment 
button.  To view the comment, press the Comment button.

Whether or not an archive contains a comment, you may press the 
Comment button to edit the archive comment.  Pressing the Comment 
button brings up the comment editor.  Any current comment is 
displayed.  You may edit the comment by inserting or deleting 
text, or using the copy and paste buttons to insert text from 
another source.  To delete a comment, select the entire comment 
and press the DEL button.  When you are finished, press OK.  If 
you have made changes to the comment, ZipShell Pro will ask you 
if you want to save these changes back to the archive.  If you 
reply "Yes", the new comment will be inserted into the archive 



(or the comment will be deleted, if you deleted the entire text 
of the comment).  If you reply "No", changes to the comment are 
discarded and the archive remains unchanged.

INTERNAL EXTRACTION / COMPRESSION

ZipShell Pro has the ability to extract most ZIP and ARJ files 
internally, without shelling to DOS to use PKUNZIP.EXE or 
ARJ.EXE.  It also has the ability to create ZIP archives 
internally, which are 100% compatible with PKZIP.  ZipShell Pro 
will automatically use these internal routines whenever possible, 
unless you have specified otherwise by unchecking the checkboxes 
labelled "Use Internal Zip & Unzip when possible" and "Use 
Internal Unarj when possible" on the Internal Extraction dialog 
box (available from the Setup menu).

There are a few instances where ZipShell Pro cannot extract a ZIP 
or ARJ file internally.  In this case, it will shell to DOS in 
order to run ARJ.EXE or PKUNZIP.EXE.  This most commonly occurs 
when working with encrypted files.  ZipShell Pro also cannot 
internally compress files with password encryption, but will use 
PKZIP.EXE instead.

Using internal extraction / compression is often faster than 
using one of the DOS-based programs, because ZipShell Pro does 
not have to spend time establishing a DOS shell or launching 
another program.  The internal archiving routines also provide 
you with a graphical measure of progress via a percent-complete 
bar which is displayed during the extraction and compression of 
files.

ADVANCED FEATURES

ZipShell Pro is capable of many advanced compression/ 
decompression features, including password encryption/decryption, 
path inclusion, volume label inclusion, compression method 
selection, and more.  When extracting or compressing files for 
which extended options are available, they will be automatically 
displayed.  Pressing the Help button will bring up a detailed 
explanation of each.

ZipShell Pro also includes the ability to convert an archive from 
one type to another (for example, ARJ to ZIP), or between 
versions for ZIP archives (for example, it can convert a ZIP 1.10 
file to a ZIP 2.04 file or vice versa).  To access ZipShell Pro's 
conversion functions, select the Convert command from ZipShell 
Pro's File menu.

REGISTRATION / CUSTOMER SUPPORT

The single-license registration fee for ZipShell Pro is $29.95.  
In return you will receive a diskette containing the latest 
version of ZipShell Pro (without the nag screen!) and 



accompanying  documentation files, along with a unique 
registration number.  Additionally, your name will be displayed 
in the "About" box as the registered user.  Registering ZipShell 
Pro enables us to continue to develop high-quality, inexpensive 
software for you to use, so please support the Shareware concept 
and register this program if you find it of use!  Also, if you 
register you will be eligible for discounts on futures upgrades.

Commercial site licenses are also available.  Please refer to 
ZSORDER.TXT for rates.

To order, please fill out the accompanying order form 
(ZSORDER.TXT), and send to:

NewVision
800 5th Ave #382
Seattle, WA  98104

You may also register online on CompuServe.  To do this, type GO 
SWREG at any CompuServe ! prompt, and use ID 1551.  The price of 
ZipShell Pro will be charged to your CompuServe account, and 
NewVision will be immediately notified.  You should receive your 
registered copy of ZipShell Pro in about a week.

Additionally, if you have any questions, problems, comments, or 
suggestions regarding ZipShell Pro, contact us at the above 
address, on CompuServe at 76020,732, on America Online at 
NewVision1, or by phone at (206) 557-8330.  All comments and 
suggestions are appreciated and welcome.

SOFTWARE LICENSE

ZipShell Pro is not public domain software, nor is it free.  Non-
licensed users are granted a 21-day period during which they may 
use ZipShell Pro on a trial basis, to see if it is suitable for 
their needs.  After the 21-day trial period, users are required 
to register the program or discontinue using it.

Licensed users may use ZipShell Pro only on a single computer.  
It may be used on more than one computer, as long as there is no 
chance of it being used on different computers at the same time.

Licensed users of ZipShell Pro may not rent or lease the program, 
but may transfer the program, with all accompanying materials, on 
a permanent basis provided that they retain no copy of the 
program, and the recipient agrees to all terms of the Software 
License.  ZipShell Pro is protected by Copyright laws of the 
United States and must be treated like any other copyrighted 
material.  Under no circumstances may anyone disassemble, 
decompile, or reverse engineer the program.

WARRANTY DISCLAIMER

THIS SOFTWARE AND ACCOMPANYING WRITTEN MATERIALS (INCLUDING 



INSTRUCTIONS FOR USE) ARE PROVIDES "AS IS" WITHOUT WARRANTY OF 
ANY KIND. FURTHER, NEWVISION DOES NOT WARRANT, GUARANTEE, OR MAKE 
ANY REPRESENTATIONS REGARDING THE USE, OR THE RESULTS OF USE, OF 
THE SOFTWARE OR WRITTEN MATERIALS IN TERMS OF CORRECTNESS, 
ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK 
AS TO THE RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY 
YOU. IF THE SOFTWARE OR WRITTEN MATERIALS ARE DEFECTIVE, YOU, AND 
NOT NEWVISION OR ITS DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES, 
ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR, OR 
CORRECTION.

NEWVISION DISCLAIMS ALL WARRANTIES RELATING TO THIS SOFTWARE, 
WHETHER EXPRESS OR IMPLIED, INCLUDING BUT  NOT LIMITED TO ANY 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE.  NEITHER NEWVISION NOR ANYONE ELSE WHO HAS 
BEEN INVOLVED IN THE CREATION, PRODUCTION, OR DISTRIBUTION OF 
THIS SOFTWARE SHALL BE LIABLE FOR ANY INDIRECT, CONSEQUENTIAL, OR 
INCIDENTAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE 
THIS SOFTWARE EVEN IF NEWVISION HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES OR CLAIMS.  IN NO EVENT SHALL 
NEWVISION'S LIABILITY FOR ANY DAMAGES EVER EXCEED THE PRICE PAID 
FOR THE LICENSE TO USE THE SOFTWARE, REGARDLESS OF THE FORM OF 
CLAIM.  THE PERSON USING THIS SOFTWARE BEARS ALL RISK AS TO THE 
QUALITY AND PERFORMANCE OF THE SOFTWARE.  YOU MAY HAVE OTHER 
RIGHTS WHICH VARY FROM STATE TO STATE.

This agreement shall be governed by the laws of the State of 
Washington.  Any action or proceeding brought by either party 
against the other arising out of or related to this agreement 
shall be brought only in a STATE or FEDERAL court of competent 
jurisdiction located in King County, Washington.

COPYRIGHTS

ZipShell Pro and all accompanying files are Copyright © 1992-1993 
by NewVision.  All rights reserved.

Portions of ZPSUNARJ.DLL are a modified version of UNARJ.EXE, 
Copyright © 1991-1993 by Robert K. Jung.  All rights reserved.

Portions of NVZIP.DLL are a modified version of InfoZIP's 
ZIP.EXE, Copyright © 1990-1993 Mark Adler, Richard B. Wales, 
Jean-loup Gailly, Kai Uwe Rommel, Igor Mandrichenko and John 
Bush.  Source code for ZIP.EXE available upon request for a $3.00 
copying charge.

PRODUCT HISTORY

v1.00 - First public release of ZipShell
v1.01 - Fixed a bug which caused ZipShell to run slowly when viewing a 

file from within a ZIPFile on slower 386 and 286 computers.  Also 
made ZipShell check for the existence of files before extracting 
them, instead of letting PKUNZIP.EXE do it.

v1.02 - Caused ZipShell to prompt for a filename when a new file is 
created using the drag and drop method, instead of arbitrarily 



naming it new.zip, new1.zip, etc.  Made the File...Rename command 
more functional, and added a File...Close command, to close the 
current ZipFile in preparation for creating a new one with the 
drag and drop method.  Also enabled more than one file to be 
deleted from a ZIPFile at a time.

v1.03 - Discarded the ZipShell viewer (because it was too limited).  
Instead, users may use any Windows editor they like for viewing 
files within ZIPFiles.  This function is available under the 
Setup....Options command.

v1.04 - Included a dialog box to allow the user to reset the tabs in 
the main listbox, since certain system configurations would cause 
the columns to be misaligned.  Added support for PKZIP's 
authenticity verification.

v1.05 - Fixed a bug which occured when working with ZIP Files which 
contained other ZIP Files greater than 32K in length.

v1.06 - Added an option to disable the exploding window on startup; 
this is used when ZipShell is launched minimized (as in the 
Program Manager's startup group, for example).

v2.00 - Major upgrade to ZipShell 1.0x.  Added support for ARJ and ARC 
files, enabled support for archive comments.  Included support 
for many of PKZIP and ARJ's options, including password 
encryption, the joining of ARJ archives, testing an archive's 
integrity, fixing corrupted ZIP files, and more.

v2.12 - A maintenance release which enables ZipShell to work with the 
newest version of PKZIP and PKUNZIP, version 2.04c.  Also allows 
use of archiving programs which are not on the user's path.

v2.12c - Fixed a bug which caused a conflict with SHARE.EXE.
v2.30 - Added support for LZH archives using LHA.EXE 2.1x.  Redesigned 

the options windows so that they are easier to understand and 
use.  Changed the way ZipShell handles a single zipfile being 
dropped on it, so that the file is added to the current archive 
if the CTRL key is held, else the archive being dropped is 
opened.  Added support for self-extracting archives, and 
implemented a Multiple Document Interface.

v2.47 - Added the ability to extract most ZIP and ARJ files internally, 
without having to shell to DOS and use PKUNZIP.EXE or ARJ.EXE.  
Added a Sort menu to the menubar, which allows the the main 
listbox (which displays the contents of an archive) to be sorted 
by a number of different parameters.  Added the ability to create 
entire directory trees, instead of just a single subdirectory, in 
the Extract Files window.

v2.50 - Increased the speed of internal extraction; made error messages 
clearer with more help available.

v3.0 - Added internal compression ability; included routines to 
convert archives to different types and to create Windows self-
extracting archives.


